Overview of QUEST
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CURRENT STRATEGIC PLAN

STRATEGIC DIRECTION: Create and nurture a culture that values

KEY RESULT AREA
1.0 Ouest CHC known 2s an Employar of Choica

1.1 Organizational culurafstafl sticfacion mezsured and now statogies
mmdmpfuunnwkplacn expariancs identified by Masch 31, 2016
and ongoing

1.2 &y and a positiva, supportive and respecthul
omanizational cubturs fostered and maintained

KEY RESULT AREA

Z.I'.l Eﬂ'nct'rvn Board Leadarship Strategy

21 Enard racuitmant pas that reflact izational needs’
g-uwﬁlrnplmm:;mmgaiw with | aad:x.‘ development
tha Board, banptnmbnrﬂJ M5 ongoing
2.2 Framawork for Board participation in Cuality improvamant
by Dacambar 31, 2015

activitias

2.3 Board mplamentation of a2 minimum of three Community
Engagemant/Capadty Building strategias by March 31, 2017

KEY RESULT AREA

3.0 Cuualiy Nhnagﬂ'nmsmnﬁ'mmmcnsh :Errtﬂ'rnugh
continuous ceganizational and sanvioa evaluation, and improvemant

s huation and improvement processes

3.1 Continuous senica aval
dasigned and for Quest CHE Programs by
Decambar 31, 2015, and

angaing

3.2 Quests Quality Improvement: Plan and Quality Work Planiz) for ley CHC
ﬂv&sﬁmmmdvﬁnﬂlﬂy i

3.3 Ressarch opporunitics am axplored through alkances with local and
proninial leaming contres and initistives by Septambar 30, 2017

KEY RESULT AREA

4.0 Partnarships and relationships that enhance affectivancss

TARGETS

4.1 Partnarshipssarvica agreaments with community stakcholdars,
that maximiza Cuast’s apmtyr.nmspnndbo chiants' neads,
axplored and rbvulnpu-danmongang 3

4.2 Across to dental services for priosity laticns & mowased by
Mqummmmmﬂmwwbﬂm,ms

ongoing

43 Amrrrnmrtyn.ppurtmmmsl‘uh that mamimizes serice acoess’
ndabitym:iﬂrru mins aconomics of smla in aitical support
functions axph caudapndxappfmhbfmﬂ
I:‘D'I?ar\dcr\gomg

KEY RESULT AREA
5.0 Ouest’s Modal of Primary Health Cane takes into account sarvica
dalivery trands 2= wall 2= funding prioritias, whila maximizing

acoass to dient sarvicas and optimizing usa of msources

TARGETS

5.1 Staff complement aligned with programs, sanice delvery
raquiremants, cliant neads and availabla funding [ﬂlﬂ nght
parson, in tha right placs, at tha right time) by Masch 3
2016 and o

52 CHC '3I-Iad:‘|ar\-d'n\l'=||:ungrrr.=g'nmdx&ml:HC

Board/ztaff swerenass and undarst

KEY RESULT AREA

6.0 Organizational Accreditation

TARGETS

6.1 Acoraditation Reviaw complated and Wodgplan in placa by
Saptambar 30, 2017

6.2 Arcreditation achicved

KEY RESULT AREA

7.0 Privatn, municypal, provincial and fadoral fandarts
and appreciation for tha CHC Model in primary h:ﬂumm
ETS

7.1 Projects and mssarch to reinforos: the eatures and finandal benafits
f2.g. improved dient outromes, fewer unnaccsmry ER visits) of
tha CHC Modal identifiad and implamantad, and eaus
promoted by June 30, 27 and ongoing

11.3]119

by Decomber 31, 2018

KEY RESULT AREA

1.0 Healthy Individuals and commamnity

TARGETS

1.1 Equitable and timely client access to sarvicas Improved by
December 31, 2015 and ongoing

1.2 Quest’s continuum of core primary health care programs and
senvices ks enhanced to address newly identtfied neads by
March 31, 201£ and ongoing

KEY RESULT AREA

2.0 Indushvity, community leadership and active participation In
addressing the soclal determinants of health

TARGETS

2.1 Community capadty bulding opportunities Identified for
Staff and implementation underway by September 30,
2015 and ongoing

2.2 Opportunities for student placements continue to be
identified, explored and Implemented by March 31, 2014

2.3 BEvidence based sohstions to address key primary heatth care
Issues experienced by Ouest CHC Clients are Identified,
promoted and advocated for by June 30, 2014 and ongoing

2.4 Volunteer Program design finallzed and iImplementation
completed by December 31, 2016

Strategic Plan 2015 to 2018

Our Mission

CQuest CHC provides primary health care services to individuals experiencing social, economic and cultural
barniers while promoting wellness, community and social pustice.

Our Vision

A healthy and engaged community that participates, collaborates, celebrates and grows.

QOur Core Values

Quest believes that all people have a right to be treated with dignity and respect, acknowledging that all forms
of oppression including racism, sexism, ableism, heterosexism, ageism, classism and economic oppression
impact the health and well-being of individuals and communities. Board and staff operationalize this belief

by ensuring that all our actions are guided by the following values:

* Health Promation

* Empowerment
* Service Access

= Accountability
* Sustainability
# Learning and Innowation

* Holistic Practice and Collaboration
* Ecological and Environmental
Responsibility

Quest belisves that focusing on the most disadvantaged will benefit everyone in the community and society.

Financial Stewardship

KEY RESULT AREA

1.0 Financtal accountability and minimized exposure to sk

TARGETS

1.1 Fism@l nfrestruciure reviewed and updated as appmopriate by
December 31, 2015

1.2 Finandal planning processas/procedunes to madmize
accountability and use of fiscal resources identified and
Impemented by March 31, 2016 and ongoing

1.3 Perfomance Benchmarks with other CHCE In comparable
communities, developed, Implemented and monttored by
December 31, 2014

KEY RESULT AREA

2.0 Increased revenues

TARGETS

2.1 Successhd ﬁndR%applm‘uurE.SLbnmed to sources, In addition
1o the LHIM, by March 31, 2014 and on an ongoing basls

2.2 vohmteer Dental Program fundl Ihat s ms
continued operation In place by Za

KEY RESULT AREA

3.0 CHC Foundation/fundraising model

fundiaising options eg:hedarddaclsxnmadere
feasl:ilrty;h'n:delbyl"b'mta 30, A
3.2 Foundationfundraising model Iriﬂa‘hed by Manch 31, 2018

STRATEGIC DIRECTION: Build a strong, sustainable and
safe organization

KEY RESULT AREA
1.0 An effective and effident organtzation

TARGETS

1.1 Administrative policles/systems/processes to support effective
and effident service delivery and acoreditation identified and
astablished by December 31, 2015

1.2 Information collaction and participation In processes to Infiom

ﬁ.l'l:haﬁe Implementation ofnen#l.lpdamd
anagement Information Systems / Electronic Medical
Reconds completed by December 31, 2015

KEY RESULT AREA

2.0 Publdic recognition and understanding of Quest CHC asa
Registered Chartty a unique, holistic and
Interdisciplinary moded of health and wellbeing in Miagara

TARGETS

2.1 Communication/Marketing Strateqy developed and
Implemented by December 31, 2015 and ongolng.

2.2 Sodal Media strategles in place by March 31, 2014

KEY RESULT AREA

3.0 Permanent Site/Physical Space that meats MOHLTC standands:
and Quast CHC requirements

TARGETS

3.1 MOHLTC & LHIN approval for Cuest CHC Permanent Site
Stage Two Functional Pm-gmm bdenber.H s

3 P o Enﬁemwnphhdhlarm.]‘l g

KEY RESULT AREA
4.0 Organtzational structure that Incnrpummime potential
rgaewemnmlesofsmle to be achieved through
Integrated administrative funcitions and back office supporis

TARGETS
41 Cﬂ:um.lnesfurmdlﬁshil of back office
e mmaﬂhmmmmﬂymﬂmaﬂm

September 30, 2014

KEY RESULT AREA
5.0 Cuest operational In penmanent space
TARGETS

541 Tmmmmnhazﬁfonnmw anent space prepared
by Decamber 31, 2016 iy

5.2 Trarestion Plan to support move: to anent space
Implemented by June 30, 2017. == =

Community Health Centre
@ Every One Matters.




Client and Community Perspective

» Equitable & Timely Service Access
> Shared care model for frequent visitors
> Call Reminder System
- Same Day Service
- "Refresh” Intakes Project
> Urgent Service Slots
- Efficient hospital transitions — appt. 7 days post discharge
> 50+ LGBTQ Needs Assessment
> USAT expanded to include “7 points of service”
> Chairs/coordinates/hosts Niagara MH&A Complex Care Meetings
> Health Equity Action Planning (HEAP) Table
> Syrian Refugee Committee
> Equity measurement introduced in Quest Quality Improvement Plan




Client and Community Perspective

» Enhanced continuum of core primary health care services
> Volunteer Chiropractic Program
> Senior Pride Network Niagara Funding
- Aging Strategy Implementation Niagara Leadership Council Funding
> |nvitation to sit at HNHB LHIN Action Tables (MH&A and HealthLinks)
> Increased psychiatric services access

> Participation in Opioid Prevention Network/Steering Cmte & Work
Groups; Naloxone training & distribution

> New Groups for Clients

- MAWP expanded to include Vineland and Beamsville farms;
volunteer physiotherapist/dietician services provided

- New strategies to obtain client feedback re current/future programs
> Diabetes Clinic

- Harm Reduction Principle




Client and Community Perspective

» Community Capacity Building

« Community Health and Well Being Week
Training opportunities for community partners
e Spinal Stenosis Boot Camp
e Trans care learning opportunities
Meetings with/presentations to municipalities
Welland “CHC” being developed/funding proposal submitted
Participation at Niagara Connects Tables

Mental Health & Addictions Charter

Investing in People Leadership Group

Proposal to Trillium re Regional “Getting There” Project
» Students Placement Opportunities

« Primary care; therapists; kinesiology/recreation and leisure
« Partnered with Brock re developing/delivering course

SPAN380/480: Im/migrant Community Outreach, Research and
Internship




Internal Business Perspective

4

Administrative policies/systems/processes to support effective &
efficient service delivery

« Administrative & HR policies

« Medical directives/standing orders established &/or updated

» Intake and Audit forms re peer audits and controlled substance use

« MAWP procedures

Increased Public Recognition
« Marketing and Communication Workplan
« M& C Workgroup & Raising Awareness Project
« M&C Environmental Scan completed - clients/board/staff/community
« Workplan incorporating information from ES prepared/approved
« StoryBrand concept introduced/Board & Mgt participation in Wrkshp
« Social Media Strategies
« Revised Website completed/updating ongoing

* Presentation to community groups/newspaper articles/ Niagara
Connects Webinars/

« Awards - AOHC Transformative Change Award; GNCC Women in
Business Social Enterprise Award Finalist




Internal Business Perspective

4

Capital Project Functional Program/Toolkit completed

Functional Program Stages 2a and 2b completed/submitted
Technical Building Assessment completed
« Board decision to expand RFP beyond current location

Quest identified as one of six “pilots” for CHC-IO Pilot Capital
Project

Revised contracts negotiated with Ministry/lO, in conjunction with
lawyer

Sections BC_1 To BC_5 of Capital Project Toolkit completed in
conjunction with MOHLTC;

Section BC_6, space allocation, being negotiated
Facility Advisory Committee in place

Meetings with Architect and Colliers Real Estate regarding site
selection




Organizational Capacity Building

» Organizational Culture Survey, Analysis and Workplan

» Retention and Recruitment Funding
» Increased salaries
« HOOPP implementation

» Board Recruitment Strategies

« Client participation

« Client Advisory Committee

« Dental Advisory Committee

* Full Board member turnover since 2014 /current complement of 10
» Board Development Strategies

« Orientation process reviewed/revised

« Board Mentorship Program in place

« Process for Executive Committee election established/approved

» Board Review and Approval of Quality Improvement Plans

» Implementation of Community Engagement/Capacity Bldg
Strategies - e.g. M&C Planning; AOHC Board to Board Report;
response to “Patients First”; Strategic Planning; Poverty Related
Initiatives (Point in Time; Be Well Survey; Chew on This; Put Food

in the Budget)




Organizational Capacity Building

» Service evaluation and improvement processes
designed/implemented
« Information being collected re alc (blood sugar levels) for clients
 Feedback Informed Treatment Evaluation (FIT)
« Working with Wilfred Laurier re MAWP evaluation and article

» Partnerships and Service Agreements that maximize capacity
to respond to Client needs
« USAT Project received Transformative Change Award
« Funding for Volunteer Dental Program
* Membership on Niagara Sub-Region Anchor Table & Action Tables
* Chairing Complex Care Resolution Table

» “Getting There” Consortium Model for centrally dispatched access
services

* Cancer Coach

« Partnering with EMS/NH/CMHA/ to support EMS’s mobile
integrated care team project

10



Financial Stewardship

» Fiscal Infrastructure reviewed/updated
» Maximize accountability/fiscal resources

- Additional USAT Staffing

- Staffing/Admin efficiencies implemented

« Participant in AOHC study re CHCs with highest SAMI scores
» Successful Funding Applications

« Community Health Worker - LGBTQ

« Volunteer Dental Program

» Clinical Best Practices Spotlight Organization

11



Outstanding Considerations

Client and Community thérgjét?vues'”ess

» Equitable & timely access

» Enhanced primary health care
to address newly identified
needs (e.g. Western Hill; North
St. Catharines {Niagara, Scott,
Grantham, Linwell); Thorold)

» LHIN-wide Trans Service
Access

» Volunteer Program

» EMR

» Communication Marketing
Strategy in place/being
implemented, including social
media

» Capital Project

» Back office support functions

» Board/Board Committees/ and
Staff Policies/ Procedures/TOR
reviewed & updated

12



Outstanding Considerations

Organizational Capacity Financial Stewardship

4

Framework for Board 3
Participation in Quality
Improvement >

Board Community Engagement )
strategies

Research

Community Support Services
Hub

Staff complement aligned with
community need/Equitable &
timely access

Accreditation

Financial Infrastructure
reviewed/updated

Financial Planning

Increased Revenues -
Operational Funding; Fund
Raising models reviewed/
identified; Volunteer
Chiropractor Program; stable &
ongoing Volunteer Dental
Program

13



SCOT Analyses Summary

Strengths, Challenges, Opportunities and
Threats




Strengths (1)

Staff & Culture * Quest is extremely client focused - community based, community driven
and look after the most marginalized in the community. A beacon and a
safe place to go to - other docs (primary care) may not want to spend as
much time

» Front line staff have good relationships and working together -
multidisciplinary approach.

» Great place to work

» Generous pay and benefits - should be attractive for recruitment

¢ Management put in long hours

Partnerships e Quest works well in partnership with other agencies such as Start Me Up

Niagara, Public Health Ontario Telemedicine Network (OTN) & Dental, St
Joe’s Geriatric Mental health and local pharmacists.

» Urgent Service Access Team (USAT) works well in partnership with
hospital and other agencies such as shelters, methadone clinics,

* Migrant workers program - partnerships with McMaster, >80 volunteers,
and Grand River CHC.

e ICL (Inter-disciplinary care lead) approach with community
partners/Health Links

* North Hamilton CHC for back-office IT support

Breadth of Vulnerable » Recognition by most partners of Quest’s clients having high needs and
Populations served difficulty accessing services.
« Right location for a CHC - current neighbourhood provides good access
for clients.



Strengths (2)

Quality of programs e Most services including migrant workers, USAT and Trans Care,
consistently had positive feedback across all interviewees.
e Low barriers to access for clients

Reputation of this program is very good and it is well-recognized as a
really good service.

e Clients from all over the province.

e Physician serving this community is held in high regard and is in high
demand.

Trans and LGBTQ programs




Challenges (1)

Partnerships - Cross e CHGCs still newer organizations in Niagara community and not very well
Agency Collaboration understood by partners, funders or community.
e Does LHIN recognize value of Quest and its approach?
» Need to improve some partnerships:
» Housing, food security and other services that clients need and LHIN

engagement
Community Need & Wait * Quest CHC does not have capacity to deliver services to meet need - currently
Lists 4,000 clients but the Association of Health Centres (AOHC) analysis indicated

closer to 17,000 potential clients.
« Wait lists/service capacity are top of mind for clients, partners, staff,
management and Board.
LGBTQ clients are aging - population is aging generally
CHC Hours of service are an issue for clients
Primary care wait - not open to new clients
Mental health counseling is a big need - Quest clients are waiting 2 months

Funding » Many issues/challenges deemed to be due to lack of funding to adequately
address service need

Programming requirements « Need to formalize and achieve funding for various programs such as dentistry,
chiropractic services, and psychiatric services.
» Increasing need for mental health and addictions services.
* Need for physiotherapy services.
« Address client food security and general dietary issues - (community kitchen,
diabetes and other special diets, foodbank)




Challenges (2)

Lean Management Structure ¢ Executive Director (ED), program director and manager - need more middle
management support, possibly with clinical background.
« Organization is spread thin - lots going on and need to be at a variety of
planning tables

Internal Processes  Structure of the clinic not putting all the responsibility on the front desk -
Medical secretaries vs client coordinators - back desk and front desk approach?
« Improve focus on quality improvement - e.g. only recently started tracking
referrals and follow-ups on our clients.
« How many clients do they actually see? Only seeing 10% of the population - 90%
of the population are not being seen

Staff » Recruitment and retention of doctors has been a problem
e Succession planning for ED/program director
 Strategic Plan not internalized by staff

Building * Need for a new building - Current building is limiting access, flow and teamwork.




Opportunities

Partnering New ways of working with other CHCs - opportunity for greater collaboration and
unified regional approach.
Regional planning - sub-LHIN areas creates an opportunity for leadership.

New Service Delivery Utilization of technology - OTN services for clients from out of St Catharines.
Models/Clinical Hours of service -satellites at partner organizations
Efficiency Create more outreach services.

Use of social media - opportunity with the Trans population
Primary care/system Expansion/promotion of the model of health and well-being to other types of
reform primary care models.

New models of care for home and community care due to integration of Home &
Community Care (formerly Community Care Access Centres, CCACs) services into the
LHINs.

Ability to inform/educate provincial election nominees/MPPs from various parties

Community Capacity Education for others - sharing expertise outside of the CHC (education and training)
Creating More Robust Currently management model is considered too lean. There is an opportunity to
Management Staff modify and provide increased opportunities for more levels of staff and management.
Model




Threats/Risks

Lack of Brand recognition Average person does not know Quest CHC or what it does. This has
beyond immediate partners implications for fund raising

and clients

Wait Lists Wait lists for primary care services are high

Staffing Risk related to management succession due to size of small team

Physician recruitment

Political Environment Election creates uncertainty. What is the future of CHCs under new
government?

Primary care reform FHTs getting into “CHC business” - creating less resources for CHC

Perception of QUEST by HNHB LHIN not enthusiastic toward QUEST or CHCs in general

LHIN
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